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  مقدمه

چنين خودآموزهايي در  ءبا توجه به نياز روز افزون علاقه مندان حوزه طراحي وب در ايران به وجود خودآموزهاي مرتبط و خلا

خودآموز طراحي وب وب فارسي، تصميم گرفتم تا به كمك چند تن از دوستانم كتابچه اي الكترونيكي و رايگان موسوم به 

  .خود آموز مرحله به مرحله تقديم شما مي شود 4در اين كتاب  .را تدوين كنم به صورت عملي

در انتهاي اين  .كمال تشكر را دارم محمد اعظم رحمان پورو آقاي  ندا اكرميمجددا از همكاري صميمانه دوستانم يعني خانم 

با اجازه خود ايشان درج شده تا مجموعه  فرشاد ذوالفقاريكتاب نيز يك خودآموز ساده و مفيد از طراح به نام ايران يعني آقاي 

  .كاملتر گردد

افزار فوتوشاپ و همچنين تبديل طرح هاي  در اين كتاب، برگردان فارسي چند خودآموز مفيد طراحي قالب وب سايت در نرم

در ابتداي هر . به صورت مرحله به مرحله و مصور براي شما علاقه مندان قرار داده شده است HTML/CSSكشيده شده به كد 

  .بخش منبع خودآموز نيز جهت حفظ حقوق مولفين اصلي و همچنين آشنايي بيشتر خوانندگان درج شده است

مي خواهند مهارت  آشنا بوده و HTML/CSSكه با مباحث  اب افراد مبتدي و در سطح ميانه هستندمخاطبان اصلي اين كت

براي مطالعه اين . هاي طراحي وب خود را بهبود بخشيده و به صورت عملي با بخشي از اين صنعت پويا و جذاب آشنا شوند

نرم  ،پيشنهاد من در مورد ويراستار. داريد) Code Editor(كتاب نياز به نصب نرم افزار فوتوشاپ و همچنين يك ويراستار كد 

  .است ++Notepadافزار رايگان و محبوب 

  )Copyright(حق نشر 

منتشر شده و اين مجوز به اين  ShareAlike-Noncommercial-Creative Commons Attributionsاين اثر بر اساس مجوز 

معناست كه ماداميكه  قصد فروش اين اثر به ديگران را نداشته باشيد مجاز به انجام هر گونه تغيير و افزودن محتوا به آن هستيد و مي 

  .توانيد آن را با ديگران به اشتراك بگذاريد

  

  

  

  

  

  1391پاييز 

  حامد تكميل

silvercover@gmail.com 

http://silvercover.me 



من يك خيال پرداز خوش بين هستم كه هميشه دنبال عملي كردن ايده هام 

از طريق آزادكاري هزينه هاي زندگي رو در ميارم و با وردپرس رفاقت 

منعكس  وبلاگممن اگر حرفي براي گفتن داشته باشم اون رو توي 

. آرام و بي هياهو به فعاليت خودم ادامه مي دم

چيزهاي رايگان زياد مي سازم تا هم تفريح كرده باشم و هم اعتماد شما رو بيشتر 

جلب كنم تا از اين رهگذر اگر رضايت خاطري براي شما حاصل شد افتخار 

  . ژه تجاري رو با هم داشته باشيم

  خودآموز طراحي وب به صورت عملي

  )silvercoverبا نام مستعار 

من يك خيال پرداز خوش بين هستم كه هميشه دنبال عملي كردن ايده هام 

از طريق آزادكاري هزينه هاي زندگي رو در ميارم و با وردپرس رفاقت . هستم

من اگر حرفي براي گفتن داشته باشم اون رو توي . ديرينه اي دارم

آرام و بي هياهو به فعاليت خودم ادامه مي دم شبكه هاي اجتماعيمي كنم و در 

چيزهاي رايگان زياد مي سازم تا هم تفريح كرده باشم و هم اعتماد شما رو بيشتر 

جلب كنم تا از اين رهگذر اگر رضايت خاطري براي شما حاصل شد افتخار 

ژه تجاري رو با هم داشته باشيمهمكاري در پرو

خودآموز طراحي وب به صورت عملي
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  بخش شماره يك

پوسته يا قالبي كه در اين . آموزش اين بخش مربوط به كشيدن يك پوسته چشم گير و تميز با استفاده از فوتوشاپ است

لطفا اين آموزش مهيج و  .آموزش ساخته مي شود را مي توان در سايت هاي شركتي و شخصي به خوبي مورد استفاده قرار داد

  .مفيد را تا انتها دنبال كنيد

  

  منبع آموزش

http://sixrevisions.com/tutorials/photoshop-tutorials/create-a-clean-and-professional-web-

design-in-photoshop/ 
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  ژه در فوتوشاپراآماده سازي پ

در فوتوشاپ ايجاد كنيد، از تنظيماتي كه در عكس زير نشان داده شده استفاده ) Ctrl + N(ژه ي جديد رايك پ -1

  .كنيد

  

  

  تنظيم كنيد اواحد ها ر

باز كنيد  را Preferencesپنجره ي . ست استفاده كنيداكه واحد استاندارد براي طراحي وب  pixelاز واحد  -2

)Ctrl/CMD + K(  ي راوUnits & Rulers اعمال  اكليك كنيد، تنظيماتي كه در عكس زير نشان داده شده ر

  .كنيد

  

  .اضافه كنيد ار) Guides(محتوا، خطوط راهنما براي مشخص كردن محدوده ي 
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از كليد ميانبر  Rulers) يا عدم نمايش(براي نمايش . فعال كنيد ار  View > Rulers  ،Rulersاز منوي  -3

"Ctrl/CMD + R" از منوي . استفاده كنيدView > Info  پنل ،Info كليد ميانبر(باز كنيد  ار :F8 .( اين

  .دده ارائه مي اانتخاب كرديد اطلاعات مفيدي رپنل بسته به ابزاري كه 

از گوشه چپ صفحه  120pxيك مربع با عرض . شودانتخاب  Rectangular Marqueeبزنيد تا ابزار  ار "M"كليد 

  .كمك بگيريد Infoنيد از پنل اتو براي تنظيم ابعاد مربع مي. ايجاد كنيد

  به سمت راست مربع بكشيد راسمت چپ صفحه كليك كنيد و يك خط راهنما ) Ruler(ي خط كش را

  

  بكشيد به گوشه ي سمت راست صفحه و يك خط راهنما به سمت چپ مربع اضافه كنيد رامربع  -4

  )پيكسل فاصله دارد 120ه از هر سمت حه كفدو خط راهنما در دو طرف ص( شكل زير باشد يكبايد شب حالا صفحه
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  طراحي لوگو

  .لوگو طراحي كنيم هيم براي وب سايت يكمي خوا خب حال -5

  .بگذاريد "logo"آن را و اسمش ) Layer > New > Group(جديد اضافه كنيد  گروهيك 

مي (ف بزرگ تايپ كنيد رابا ح ار  ”SMASHING“انتخاب كنيد و  ار) Horizontal Type Tool” )T“ابزار  - 6

 ).را درج كنيد نااسم وبسايت خودت توانيد

  

همچنين گزينه ي . انتخاب كنيد 42pt او اندازه ر Bold ار Arial ،Style فونت را ”Character“پنل  در -7

“Anti-aliasing method” را Sharp  ااين تنظيمات ر. استفاده كنيد ”101112#“انتخاب كنيد و از رنگ 

  .نيد تنظيم كنيداتو هم مي Option Barست، در افعال  Typeوقتي ابزار 
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ي راانتخاب كنيد،  ار ”Gradient Overlay“. شودباز  ”Layer Style“دابل كليك كنيد تا پنجره ي  -8

“Gradient Editor” مطابق شكل زير اعمال كنيد اكليك كنيد و تنظيمات ر.  
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سمت چپ قرار ) راهنما(از خط  0pxاز بالا و  35pxبه فاصله ي  را ”SMASHING“ي مربوط به متن  لايه -9

 .بدهيدانجام ) كيبورد( يو كليدهاي جهت) Move” )V“با استفاده از ابزار   انيد اين كار راتو مي .يدهبد

جابجا كنيد و بعد از كلمه  اي جديد ر لايه). Layer > Duplicate Layer(كنيد  )تكثير( Duplicate را لايهاين 

تكرار كنيد، اما براي كلمه  را 8و  7، 6مراحل . بدهيدتغيير  ”Dzine“به  هيد، متن آن راقرار بد ”SMASHING“ي 

 Left color stop: #b27625, Right(استفاده كنيد  ”Gradient“از رنگ متفاوتي براي  ”Dzine“ي 

color stop: #e5ad27 (  

انتخاب كنيد و يك نوشته زير لوگو اضافه كنيد، از تنظيمات زير  را) Horizontal Type Tool” )T“ابزار   -10

 .استفاده كنيد
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 < View > Showغيرفعال كردن خطوط راهنما به /براي فعال. دتصوير زير شد باش يكلوگو ي نهايي بايد شب  -11

Grid يا از كليد ميانبر  رفتهCtrl/CMD + ; استفاده كنيد.  

  

  يا نوار پيمايش Navigation Bar ساخت 

  .باشد ”logo“ گروهبايد بالاي  گروهاين ، زاريدگب ”navigation“ ار آن جديد ايجاد كنيد و اسم گروهيك  -12

 ”Rectangle“ابزار . يدهاز لبه ي بالاي صفحه قرارش د 150pxبكشيد و به فاصله ي  Guide يكاز خط كش بالا 

)U (4انتخاب كنيد و يك خط افقي به ارتفاع  ارpx  و رنگ#e3ab27 در امتداد صفحه رسم كنيد.  

از خط راهنماي سمت  20pxبالاي خط افقي و  12pxبه فاصله ي  ار) براي جابجاي بين صفحات سايت(لينك ها  -13

رسم  35pxدر  72pxانتخاب كنيد و مربعي به اندازه ي  ار) Rounded Rectangle” )U“ابزار . چپ رسم كنيد

  .بگذاريد ”hover“ راه زير لينك ها منتقل كنيد و اسمش ب را لايهاين . كنيد

تا با  برويدپايين تر ب 8pxبه اندازه ي  رالبه ها . صاف كنيد ”Convert Point“با ابزار  راگوشه هاي گرد پايين مربع 

باز  ”Layer Style“دابل كليك كنيد تا پنجره ي  ”hover“ي  لايهي ور. شودي لبه هاي داخلي هماهنگ  يكبق

 را ”Horizontal Type“ابزار ). b27625#تا  e5ad27#از (اضافه كنيد  Gradient Color آن و به شود

  .كنيد) سفيد( ffffff# راو رنگ قرار دهيد    ”Home“ راآن متن  انتخاب كرده و
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  ”Call Us“ساخت بخش 

اين ). دقيقاً سمت مخالف لوگو(در بالا و سمت راست طرح ايجاد كنيم  را ”Call Us“در ادامه مي خوايم بخش  -14

 ”phone icon“ را لايهاسم اين . بدهيدنزديك خط راهنماي سمت راست قرار  آن راو  دانلود كنيد راآيكن تلفن 

 رايك شماره تلفن به سمت چپ آيكن تلفن اضافه كنيد، فونت . انتخاب كنيد را ”Horizontal Type“ابزار . بگذاريد

Arial 20 را، اندازهpt  رااضافه كنيد، فونت  راپايين شماره تلفن توضيحات بيشتر . انتخاب كنيد 292929# راو رنگ 

  .انتخاب كنيد 595959#  راو رنگ  11pt راتنظيم كنيد، اندازه  Boldو  Arialي را
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 Headerساخت 

  .بگذاريد ”header“ راه جديد ايجاد كنيد و اسمش وريك گ. بسازيم را Headerيم بخش همي خوا حال -15

اين . ايجاد كنيد 440pxدر  1200pxي  انتخاب كنيد و يك مستطيل به اندازه را ”Rectangle“ابزار  - 16

ي رو. بگذاريد ”header bg“ راو اسمش  بدهيدقرار  Navigation Barپايينتر از  1pxبه فاصله ي  رامستطيل 

استفاده  Gradient Editorانتخاب كنيد و از اين دو رنگ در  را Gradient Overlayدابل كليك كنيد،  لايهاين 

  :ببينيد راعكس زير ). 7a7556#تا  2e2226#از (كنيد 
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به  رااين مستطيل . ايجاد كنيد 360pxدر  960pxبه ابعاد  ”Rectangle Tool“با ابزار  ديگريك مستطيل   -17

اسم اين . دهيداز خط راهنماي سمت چپ قرار  0pxو به فاصله ي  ”header bg“ي  لايهاز بالاي  40pxفاصله ي 

 توانيدمي  رادر تصوير زير پيش نمايشي از كارهايي كه تابحال انجام داديم . بگذاريد ”header container“ را لايه

  :ببينيد
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 ”featured project“ايجاد بخش 

ايجاد  ”header“ گروهجديد داخل  گروهيك . بسازيم را ”featured project“در ادامه مي خوايم بخش  -18

و  340pxدر  630pxانتخاب كنيد و يك مستطيل به ابعاد  را ”Rectangle“ابزار . ”fp“ بگذاريد راكنيد و اسمش 

تنظيم  000000#ي ور را لايهرنگ اين . ايجاد كنيد header containerاز بالا و سمت چپ  10pxبه فاصله ي 

  .بگذاريد ”fp container“  راكنيد و اسمش 
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 Select > Allبه . استفاده كنيد آن از featured projectدر فوتوشاپ باز كنيد تا بعنوان  رايك تصوير  -19

)Ctrl/CMD + A (و بعد به  برويدEdit > Copy )Ctrl/CMD + C .( ي  لايهبرگرديم به طراحي وبسايت، يك

كه بعنوان  را عكسي) Edit > Paste )Ctrl/CMD + V ا زدنبسازيد و ب ”fp container“ي  لايهجديد بالاي 

featured project  انتخاب كرده بوديمPaste به  را لايهاسم اين . كنيد“fp Image”  ي  لايه روي. بدهيدتغيير

“fp image” يك كنيد و راست كل“Create Clipping Mask” درونبا اينكار تصوير فقط از . انتخاب كنيد را 

  . ستاقابل مشاهده ) ”fp container“(مستطيل 

  

 Rotation Box روي Option Barاز . برويد) Edit > Transform > Scale )Ctrl/CMD + Tبه  -20

، ) ”fp image“( لايه همان روي. تنظيم كنيد را يككنيد تا زاو Enterوبار دوارد كنيد و  را 4-كليك كنيد و عدد 

Luminosity بعنوان  راBlending Mode  انتخاب كنيد لايهبراي اين.  
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 را ”Rectangle“ابزار . عنوان و توضيحات بسازيم featured projectيم براي تصوير هدر ادامه مي خوا -21

به  را لايهشفافيت اين . ايجاد كنيد 161718#و رنگ  90pxدر  630pxانتخاب كنيد و يك مستطيل به ابعاد 

  .با توجه به تصوير زير تنظيم كنيد راموقعيت اين مستطيل . بگذاريد ”title bg“ راو اسمش  بدهيدتغيير  90%
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 ”title horizontal line“ راايجاد كنيد و اسمش  9c9c9c#و رنگ  1pxدر  630pxبه ابعاد  ديگريك مستطيل  -22

  .بدهيدقرار  ”title bg“ي  لايهدر لبه ي بالاي  رااين مستطيل . بگذاريد

  :از تنظيمات زير استفاده كنيد. ساختيم، يك عنوان و توضيحات اضافه كنيد 21مستطيلي كه در مرحله ي  درون -23

  :براي عنوان

Font: Arial, color: #ffffff, size: 25pt and anti-aliasing method option: Sharp  

  براي توضيحات

Font: Arial, color: #a4a4a4, size: 12pt and anti-aliasing method option: None  
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  ”quick quote“ساخت بخش 

انتخاب كنيد و يك  را Rectangleابزار . ايجاد كنيد ”quick quote“جديد با نام  گروهيك  header گروه درون -24

 featuredاز سمت راست  10pxبه فاصله ي  رااين مستطيل . ايجاد كنيد 340pxدر  300pxمستطيل با ابعاد 

project  را و اسم آن بدهيدقرار “qq container” بگذاريد.  

، برويد navigation گروهبه . كپي كنيم رااي كه تو مرحله ي قبل ساختيم  لايه Layer Styleيم همي خوا حال -25

برگرديد،  qq containerي  لايهبه . انتخاب كنيد را Copy Layer Styleراست كليك كنيد و  hoverي  لايهي را

،  ”qq container“و  ”hover“ي  لايههر دو  حال. انتخاب كنيد را Paste Layer Styleراست كليك كنيد و 

Layer Style دمشابهي دارن.  

  

به  را ”Quick Quote“عبارت  ”qq container“ي  لايهداخل . انتخاب كنيد را ”Horizontal Type“ابزار  - 26

) ffffff#(سفيد  راو رنگ  Trebuchet MS را Font family. از بالا و سمت چپ مستطيل بنويسيد 20pxفاصله ي 

مي  Round Rectangleبا استفاده از ابزار . تنظيم كنيد Sharpي ور را anti-aliasing methodانتخاب كنيد و 

. انتخاب كنيد 3px را) Radius(انتخاب كنيد و شعاع  را Round Rectangleابزار . دي براي فرم بسازيموريم سه وهخوا

به  راها  لايهاسم اين . بسازيد) ffffff#(و رنگ سفيد  35pxدر  260pxبه ابعاد ) با گوشه هاي گرد(دو مستطيل  حال

 رابسازيد و اسمش ) ffffff#(و رنگ سفيد  75pxدر  260px  به ابعاد رامستطيل سوم . بگذاريد field2و  field1ترتيب 

field3 ابزار . بگذاريدHorizontal Type دي يك عنوان ايجاد كنيدورانتخاب كنيد و براي هر و را.  
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  خودآموز طراحي وب به صورت عملي

 

 

 submitرابسازيد و اسمش  35pxدر  80pxانتخاب كنيد و يك مستطيل به ابعاد  را Round Rectangleابزار  -27

btn بگذاريد. 

ي ور. بزنيد را Gradient Overlay، تيك شودباز  Layer Styleراست كليك كنيد تا پنجره ي  لايه روي -28

Gradient Editor  بدهيدمطابق شكل زير تغيير  راكليك كنيد و رنگ ها.  

  

 Sizeو  Bold را Styleبنويسيد،  Arialبا فونت  را ”Submit“انتخاب كنيد و عبارت  را Horizontal Typeابزار  -29

  .انتخاب كنيد را) ”submit text“و ”submit btn“( لايههر دو  Layers Panelدر . انتخاب كنيد 13pt را

 Alignو  Align vertical centersگزينه هاي  Option Barانتخاب كنيد و از  را) Move )Vابزار  -30

Horizontal centers با رفتن به منوي  راهمين كار . (كليك كنيد راLayer > Align > Vertical Centers  و

Layer > Align > Horizontal Centers بدهيدانجام  توانيد مي(.  
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يك مستطيل به . انتخاب كنيد را Rectangleابزار . ”content“ بگذاريد راجديد ايجاد كنيد و اسمش  گروهيك  -31

 0pxو به  headerتر از  پايين  30px را لايهاين . بگذاريد ”c01“ رارسم كنيد و اسمش  175pxدر  300pxابعاد 

  .طبق تصوير زير اعمال كنيد رادابل كليك كنيد و تنظيمات  لايهي رو. بدهيدنسبت به خط راهنماي سمت چپ قرار 
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 About“انتخاب كنيد و عبارت  را Horizontal Typeابزار . اضافه كنيم رايم محتواي اين جعبه هميخوا حال -32

SmashingDzine” با استفاده از ابزار . اضافه كنيد راHorizontal Type  كلمه يAbout راانتخاب كنيد و رنگش  را 

زير عنوان . دهيدتغيير  2f2f2f#به  راانتخاب كنيد و رنگش  را Smashingبعد كلمه ي . بدهيدتغيير  b47825#به 

 بسته به نياز مي(تنظيمات زير براي عنوان، توضيحات و لينك استفاده شدن . و يك لينك اضافه كنيديك توضيح مختصر 

  ).بدهيدتغيير  توانيد

  

  :براي عنوان

Font: Trebuchet MS, style: Normal, size: 24pt, anti-aliasing method: Sharp  

  :براي توضيحات

Font: Arial, style: Normal, size: 12pt, anti-aliasing method: None, color: #767676 

  



  خودآموز طراحي وب به صورت عملي

 

 

  :براي لينك

Font: Arial, style: Bold, size: 13pt, anti-aliasing method: None, color: #252525, Underline 

  

 )ffffff#(انتخاب كنيد و رنگ سفيد  را Rectangleابزار . جعبه كنار توضيحات اضافه كنيم يكيم همي خوااكنون   -33

از  10pxبه فاصله ي  رااين مربع . ايجاد كنيد 88pxدر  88pxنگه داريد و يك مربع به ابعاد  را Shift، كليد برگزينيد

دابل كليك كنيد تا پنجره ي  يهي لاور. بگذاريد ”border“ را يهاسم اين لا. جابجا كنيد) ”c01“(سمت چپ مستطيل 

Layer Style  و يك  شودبازStroke Layer Style با تنظيمات زير اضافه كنيد:  

  

 را لايهاسم اين . بدهيدقرار  ”border“ي  يهدر مركز لا را اضافه كنيد و آن 82pxدر  82pxبه ابعاد  ديگريك مربع  -34

 را) ”content“ گروه( گروهها در اين  لايههمه ي . بدهيدتغيير  d5d5d5#به  راو رنگ اين مربع  ”box“ بگذاريد

به  راجديد  گروهو اسم  برويد Layer > New > Group from layers (Ctrl/CMD + G)انتخاب كنيد، به 

“about”  دهيدتغيير.  



  خودآموز طراحي وب به صورت عملي

 

 

  

  .با هر تصويري كه مدنظرتون هست تعويضش كنيد توانيدمربع خاكستري رنگ محلي براي تصاوير هست و مي :نكته

  

و ) انتخاب كنيد را Duplicate Groupراست كليك كنيد و  گروهي ور(كنيد  Duplicate را ”about“ گروه -35

انتخاب كنيد و  را Duplicate Groupراست كليك كنيد و دوباره  services گروهي ور. services بگذاريد رااسمش 

 portfolio گروه). portfolioو  about, services(داريم  گروهسه اكنون . بگذاريد ”portfolio“ راجديد  گروهاسم 

  .مثل تصوير زير به خط راهنماي سمت راست جابجا كنيد را



  خودآموز طراحي وب به صورت عملي

 

 

  

 برويد  Layer > Distribute > Horizontal Centersانتخاب كنيد، به Layers Panelدر  را گروههر سه  - 36

  .براي ديدن تصوير زير در اندازه ي واقعي اينجا كليك كنيد. دتا از هم بطور مساوي فاصله داشته باشن



  خودآموز طراحي وب به صورت عملي

 

 

  

 راعنوان ها  توانيد مي خود نياز اساسبر ( بدهيدمثل تصوير زير تغيير را  portfolioو  servicesهاي  گروهعنوان  -37

  )دهيدتغيير 

  

  

  Footerساخت 

انتخاب كنيد و يك مستطيل به ابعاد  را Rectangleابزار . بگذاريد ”footer“ راجديد ايجاد كنيد و اسمش  گروهيك  -38

1200px  100درpx  بگذاريد را لايهاسم اين . بدهيدبسازيد و در قسمت پايين طرح قرارش “footer bg” . از

Gradient Overlay Style  ي  لايهمشابه“header bg” ي  لايهي وربراي اينكار . استفاده كنيد“header bg” 

راست  ”header bg“ي  لايهي ورو  برويد footer گروهبه . انتخاب كنيد را Copy Layer Styleراست كليك كنيد و 

  .انتخاب كنيد را Paste Layer Styleكليك كنيد و 



  خودآموز طراحي وب به صورت عملي

 

 

  

سمت چپ اضافه كنيد، از فونت  را footer linkانتخاب كنيد و متن كپي رايت و  را Horizontal Typeابزار  -39

Arial 12، اندازه يpt  و رنگ خاكستري)#dddddd (استفاده كنيد.  

  

ايجاد كنيد و  ”footer“ گروهجديد داخل  گروه يك. اضافه كنيم رايم سمت چپ قسمت اشتراك ايميل همي خوا -40

در  85pxانتخاب كنيد و يك مستطيل به ابعاد  را Rounded Rectangleابزار . ”subscribe“ بگذاريد رااسمش 

35px را لايهاين  ماس. ايجاد كنيد “subscribe btn” بگذاريد.  

  .دي ها تكرار كنيدوربراي اضافه كردن و را 26مرحله ي  -41

و  Bold، استايل Arialاز فونت . بنويسيد را ”Subscribe“انتخاب كنيد و عبارت  را Horizontal Typeابزار  -42

  .انتخاب كنيد را) ”Subscribe text“و  ”subscribe btn“( لايههردو . استفاده كنيد 13ptاندازه ي 

  .براي ايجاد دكمه تكرار كنيد را 28مرحله ي  -43

يك مستطيل به ابعاد . يدتنظيم كن 3pxي را را) Radius(انتخاب كنيد و شعاع  را Rounded Rectangleابزار  -44

210px  35درpx  با رنگ سفيد)#ffffff ( بگذاريد را لايهايجاد كنيد و اسم اين “email field” . بالاي“email 

field” يك نوشته اضافه كنيد.  
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  شماره دوبخش 

  نماي كلي

اي از قبيل افزودن چگونگي انجام اعمال سادهتوشاپ داريد و وام كه شما دانش اوليه اي از فدر اين آموزش، من فرض كرده

  .دانيدمتن، ترسيم اشكال و تغيير اندازه و چرخش اشيا را مي

به  ي استفاده كنيد تاحادر طرزيادي  يفانتز جنبه هاياز  يازي نيست هموارهن دهماست كه نشان  ينا از اين آموزشهدف 

 ياحرفه يطراح توانيد يكمي يف،ظر تعدادي از جنبه هايو  ي متفاوتها ا استفاده از قلملكه بب. جذاب دست يابيدقالب  يك

  .هدقرار د يررا تحت تاثسايت شما كنندگان يدكه بازداي انجام دهيد به گونه

در قسمت زير آن . است) navigation(كه خواهيم ساخت داراي يك سربرگ است كه شامل نام شركت و قسمت  يطرح

در ادامه، بخشي وجود دارد كه خدمات . فرآيند تجاري و برخي جزئيات اضافي را نمايش مي دهداي قرار دارد كه محدوده

  .كندمشخص را با جزئيات بيشتر توصيف مي

  .از اظهارات مشتري و نمونه اي از پروژه خاص هستيم برخي به واسطهاعتبار و اطمينان  ايجادما در حال تلاش براي همچنين 

  .است در پايين صفحه ايجاد خواهيم كرد ده كه شامل متن استاندارد حق رونوشتسا يك پاورقي يت،نها در

  

  منبع آموزش

http://sixrevisions.com/tutorials/photoshop-tutorials/how-to-design-a-clean-business-

website-with-photoshop/ 
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  ايجاد سند

 1030و  70خطوط راهنماي عمودي را در نقاط . پيكسل ايجاد كنيد 1100 در 1100يك سند جديد در اندازه  .1

  .پيكسل را مي دهد كه به راحتي براي اغلب صفحات مناسب است 960اين كار به شما پهناي  –پيكسل اضافه كنيد 

  

 

  ساختن سربرگ

را انتخاب كنيد، رنگ پس زمينه را  (U)ابزار مستطيل . براي ايجاد سربرگ ابتدا بايد پس زمينه را اضافه كنيم .2

قرار دهيد و سپس يك جعبه از سمت چپ سند به سمت راست آن به ارتفاع  (333333#)خاكستري خيلي تيره 

  .پيكسل بكشيد 130

  

  

  



  خودآموز طراحي وب به صورت عملي

 

 

  سايت logoافزودن 

 Myriadنوع قلم را . رفته و تنظيمات زير را انجام دهيد (Window > Character)در  Character Panel به .3

Pro  با اندازهpx60  و رنگ خاكستري روشن(#EEEEEE) فاصله بين حروف را . انتخاب كنيدpx40-  با . بگذاريد

  .نام را  تايپ كرده و آن را در مجاور خط راهنماي سمت چپ قرار دهيد (T)استفاده از ابزار نوشتن افقي 

  

  يا نوار پيمايش  Navigationساخت 

نام چندين . انتخاب كنيد EEE#و رنگ  px16 با اندازه  Arial، نوع قلم را navigationبراي افزودن محدوده  .4

  .از هم جدا كنيد) -(و غيره را تايپ كنيد و آنها را با خط تيره  Home, Aboutصفحه مانند 

  

  Featured Contentمحتواي ويژه يا ايجاد بخش 

و  درشترا به صورت  Myriad Proقلم . محتوا داريم) تيتر(به منظور ايجاد اين بخش، نياز به افزودن سرخط  .5

 (T)عنوان را با استفاده از ابزار . بگذاريد  -px40فاصله حروف را . انتخاب كنيد 333333#، به رنگ px60اندازه 

  . تايپ كنيد

  



  خودآموز طراحي وب به صورت عملي

 

 

  

  .تغيير مي دهيم (00BFF3#)را به رنگ  (&)براي برجسته تر كردن عنوان، ما رنگ علامت  .6

  

 اندازه BBB#را به رنگ  Myriad Proدوباره، قلم . در پايين عنوان اصلي، لازم است كه عنوان فرعي را اضافه كنيم .7

px50  و به شكلRegular عنوان فرعي را تايپ كرده و آن را دقيقاً زير تيتراصلي قرار مي دهيم .انتخاب مي كنيم. 

  

را برداشته، اندازه قلم را  (T)ابزار تايپ افقي . را اضافه كنيم در اين مرحله مي خواهيم نماي كلي از فعاليت شركت .8

px30  و رنگ آن را#CCCCCC را از سمت چپ خط راهنما به سمت (.) دنباله اي از كاراكتر نقطه . تنظيم كنيد

  .راست آن تايپ كنيد

  

براي گرفتن . آن قرار دهيد در زير ،از خط اول px40رونوشتي از اين خط نقطه چين افقي ايجاد كرده و در فاصله  .9

 .را فشار دهيد Ctrl + Jلايه ها انتخاب كرده و دكمه  panelرونوشت، لايه متن را از 



  خودآموز طراحي وب به صورت عملي

 

 

  

گذاشته و رنگ آن  px34 را  Myriad Proاندازه قلم . متن را بين خطوط نقطه چين ايجاد شده اضافه مي كنيم  .10

چندين خط متن تايپ . بگذاريد  -40له بين حروف را و فاص px42 فاصله بين خطوط را . قرار دهيد 555555#را 

يا مشابه ايراني آن ( /http://www.lipsum.comبا رجوع به سايت . كنيد

http://loremipsum.datisdesign.com ( مي توانيد متون ساختگي دريافت كنيد. 

  

و  ”first class“مانند كلمات . برجسته كنيد Tشما ممكن است بخواهيد برخي كلمات را به منظور تاكيد بيشتر  .11

“big impact” در شكل زير. 
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  افزودن جزئيات خدمات

ابزار مستطيل را انتخاب كنيد و رنگ پيش . در اين مرحله مي خواهيم توضيحات بيشتري درباره خدمات اضافه كنيم .12

پيكسل در مجاور خط راهنماي چپ  350 در 280شكل مستطيل را در اندازه . قرار دهيد 00AEEF#زمينه را 

  .بكشيد

  

 thumbnailبر روي . ( كنيماستفاده مي drop shadowاز لايه براي اينكه مستطيل برجسته تر نشان داده شود،  .13

رنگ سايه را خاكستري .) باز شود  Layer Stylesلايه ها دابل كليك كنيد تا پنجره  Panelلايه در 

(#AAAAAA) قرار دهيد. 



  خودآموز طراحي وب به صورت عملي

 

 

 

  .با اين كار مستطيل برجسته تر نمايش داده مي شود

 

و رنگ  px40را به اندازه  Myriad Proرا انتخاب كنيد و قلم  (T)ابزار . اكنون بايد عنوان خدمت را اضافه كنيم .14

از گوشه چپ مستطيل تا  (Text box)يك جعبه متن . تنظيم كنيد Regularو به شكل  (FFFFFF#)سفيد 

  .سپس  عنوان را تايپ كنيد. راست آن بكشيد و ترازبندي آن را مركزي قرار دهيد



  خودآموز طراحي وب به صورت عملي

 

 

 

 .اريد و يك خط از نقطه چين تايپ كنيدبگذ px  18در اين مرحله اندازه قلم را .15

 

در آن . قرار داده و يك جعبه متن از سمت چپ مستطيل تا سمت راست آن بكشيد 15به دنبال آن، اندازه قلم را   .16

  .توصيفي از خدمت موردنظر بنويسيد



  خودآموز طراحي وب به صورت عملي

 

 

 

 (0076A3#)ابزار مستطيل را انتخاب كرده، رنگ را آبي . اي در پايين مستطيل ايجاد كنيمدر پايان، بايد دكمه  .17

  .پيكسل رسم كنيد 40*230قرار دهيد و مستطيلي در اندازه 

 

استفاده  235162#من از . ي تيره تر از آبي اضافه كنيدرا با رنگ سايه Inner Glowبه دكمه ايجاد شده جنبه   .18

  .امكرده
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 GET MORE": بگذاريد و با حروف بزرگ بنويسيد px  18اضافه كردن برچسب به دكمه، اندازه قلم رابراي  .19

DETAILS>>" 
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  .شكل بالا اولين مستطيلي است كه ايجاد شد

بين آنها به طور  Move (V)به كمك ابزار . دو رونوشت از اين مستطيل با تمام جزئيات درون آن ايجاد كنيد  .20

  . متون نوشته شده در هر مستطيل را نيز تغيير دهيد. كنيد مساوي فاصله ايجاد

 

به منظور خاتمه اين قسمت، يك رونوشت از خط نقطه چين بزرگي كه در گام هاي قبلي ايجاد كرديم گرفته و آن   .21

  .را به انتهاي اين بخش اضافه كنيد
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  انرضايت نامه هاي مشتري بخش افزودن

و رنگ  px24 با اندازه  Myriad Proنوع قلم . يك عنوان ايجاد مي كنيم در بخش رضايت نامه مشتري، ابتدا  .22

  .را بنويسيد "Client Testimonials"عبارت  (T)انتخاب كنيد سپس با ابزار  (555555#)خاكستري تيره 

 

براي قرار دادن عكس نويسنده رضايت نامه، ابزار مستطيل را انتخاب كرده و رنگ آن را خاكستري روشنتر   .23

(#CCCCCC)  پيكسل رسم كنيد 84 در 84بگذاريد و جعبه اي با اندازه.  
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  .عكسي با ابعاد تااندازه اي كوچكتر آماده كرده و آن را در لايه بالاي لايه پس زمينه اضافه كنيد  .24

 

رنگ . را انتخاب كنيد px14 با اندازه  Arialقلم . سپس، لازم است كه توضيحاتي در كنار عكس اضافه كنيم  .25

كه در بخش رضايت نامه مشتري براي عنوان استفاده كرديم را انتخاب كنيد و  (555555#)خاكستري تيره 

  .)براي اين كار استفاده كنيد lorem ipsumدوباره مي توانيد از . ( توضيحات خود را بنويسيد

 

در خط بعد مشخصات و وابستگي . يسنده را بنويسيدتنظيم كنيد و نام نو boldدر اين مرحله، قلم را به صورت  .26

  .تايپ كنيد (00AEEF#)را با رنگ آبي روشن ) شركت نويسنده/به طور مثال نام سازمان(نويسنده 
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آنها را با فاصله مناسب در زير . دو رونوشت از تمامي عناصري كه در ايجاد اولين رضايت نامه استفاده شد تهيه كنيد .27

 .و عكس و محتواي هريك را به طور متناسب تغيير دهيد يكديگر قرار داده

 

بدين منظور يك . مي خواهيم يك خط تقسيم كننده عمودي در سمت راست قسمت رضايت نامه ايجاد كنيم .28

درجه  90خط را حدود . رونوشت از خط نقطه چيني كه قبلاً ساختيم ايجاد كرده و نيمي از نقطه ها را پاك كنيد

Edit > Transform > Rotate 90 ن به مسير  با رفت(بچرخانيد 
o
CCW ( و آن را در سمت راست بخش رضايت

  .نامه هاي مشتري قرار دهيد
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  هاي ويژهايجاد بخش پروژه 

 با اندازه  Myriad Proنوع قلم را . براي ايجاد محدوده پروژه خصيصه دارشده، ابتدا بايد عنوان را اضافه كنيم .29

px24  تنظيم كنيد و عبارت  (555555#)و رنگ خاكستري تيره"Featured Project" را بنويسيد.  

 

 .عنوان مربوط به اين بخش را بنويسيد (888888#)به رنگ خاكستري  px20با قلم اندازه  .30
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  .پيكسل ايجاد كنيم 200*  340در زير عنوان، بايد تصويري از پروژه در اندازه 

 

و رنگ خاكستري  px14 با اندازه  Arialقلم . سپس متني كه شامل توصيف مختصري از پروژه است را اضافه كنيد .31

  .انتخاب كنيد و چند خط تايپ كنيد (#555555)

 

 Click Here For"شامل مضموني شبيه به  (00AEEF#)همچنين متني در پايين متن قبلي با رنگ آبي روشن  .32

More Details." بنويسيد.  

  .در پايان، رونوشت ديگري از خط افقي نقطه چين در پايين اين قسمت قرار دهيد .33
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  ايجاد پايين سايت

را انتخاب كرده و محتويات  888888#و رنگ  px  16با اندازه Arialقلم . ايجاد پاورقي به راحتي انجام مي شود .34

  .پاورقي را بنويسيد

 

 .طراحي انجام شداكنون 
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  حرف آخر

آموزش، اميدوارم كه توانسته باشم نشان دهم كه شما همواره نياز به جنبه هاي فانتزي بسيار براي خلق يك طراحي در اين 

  .گاهي اوقات با تركيبي از قلم ها و رنگ ها با چند جنبه ماهرانه مي توان كار زيبايي را خلق كرد. زيبا نداريد

  .از اين طرحي كه ايجاد كرده ايد را بسازيد XHTMLب در بخش بعدي به شما نشان خواهم داد كه چگونه يك قال
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  بخش شماره سه

  .ايجاد كرده ايد بسازيددر بخش قبل  طرحي كهاز  XHTML/CSSشما نشان خواهم داد كه چگونه يك قالب  بهبخش  اين در

  

  منبع آموزش

http://sixrevisions.com/tutorials/photoshop-tutorials/how-to-design-a-clean-business-

website-with-photoshop/ 
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  قبل از شروع

شما به اين فايل براي استخراج عكس هايي كه . ساختيم، داريدقبلي را كه در آموزش  يحاصل كنيد كه فايل فتوشاپاطمينان 

اگر هنوز بخش اول آموزش را مطالعه نكرده ايد به شما توصيه مي كنم كه قبل از . در قالب قرار خواهيم داد نياز خواهيد داشت

  ) اول دانلود كنيد  آموزش را از  PSDيا حداقل فايل ( برويد  به سراغ قسمت قبل  شروع اين بخش

  داريد  HTMLو  CSSاي در مورد من فرض مي كنم كه شما دانش پايه) 2قسمت (در اين آموزش 

  ايجاد ساختار فايل

-يا هر نام ديگري كه ترجيح مي(نامگذاري كنيد   templateايجاد كنيد و آن را  desktopيك پوشه خالي روي  -1

  .)دهيد

كه بـراي  خواهد بود اين پوشه شامل همه عكس هايي  -ايجاد كنيد imagesدرون پوشه خالي پوشه ديگري به اسم  -2

  .نمايش در قالب نياز خواهيم داشت

 .ايجاد كنيد reset.cssو   index.html   ،style.cssيل جديد با نام هاي اف سهسپس  -3

  

  cssفايلي است شامل تمام كد   style.cssبرا ي قالب را مي نويسيم در حالي كه  HTMLما تمام  index.htmlدر فايل 

  . كه باعث مي شود  همه چيز زيبا و مطلوب به نظر برسد

 reset.cssتنظيم 

دليل اصلي اين كار اين است كه مرورگرهاي . استفاده كنيم reset stylecheetما مي خواهيم از يك  reset.cssدر فايل 

ها و  براي مثال اندازه عناوين ، اندازه حاشيه( را نشان مي دهند  HTMLه روش هاي متفاوت عناصر گوناگون مختلف ب

padding  استفاده از يك ). هاreset stylesheet باعث كاهش اينگونه ناسازگاري ها مي شود.  

خـود   reset.cssاستفاده خواهم كرد، كد آن را درون فايـل   Eric Meyerنوشته شده توسط  Reset CSS من از  -4

 .كپي كنيد
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 پايه HTML  كداضافه كردن 

محبـوب وب در   IDEيـك  ( Codaمـن از  . را با استفاده از يك ويراشـگر كـد بـاز كنيـد     index.htmlاكنون فايل  -5

براي اين آموزش استفاده خواهم كرد، اما شما مي توانيد از هر برنامه ديگـري كـه تـرجيح    ) سيستم عامل مكينتاش 

يك سـاختار مبنـا بـراي     .را پيشنهاد مي دهم ++Notepadبراي محيط ويندوز ويرايشگر  .مي دهيد استفاده كنيد

ــفحه  ــد  HTMLص ــافه كني ــد اض ــاي   - جدي ــه ه ــتر برنام ــع  بيش ــد منب ــگر ك ــل (ويرايش  Adobeو  Codaمث

Dreamweaver ( تابعي براي اين كار فراهم مي كنند ) در ). يا به صورت خودكار آن را براي شما انجام مي دهنـد

  .پايه آمده است HTMLزير يك قطعه كد براي نشانه گذاري 

 

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0  Transitional//EN"  
"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd"> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
 <head> 
 <meta  http-equiv="Content-Type" content="text/html;charset=UTF-8" /> 
 <title>My HTML  Website Template</title> 
 </head> 
 <body> 
 </body> 
</html> 

 

  هاي خودتان stylesheetارجاع به 

اصلي ما اشـاره   stylesheetشما بايد خط كد زير را اضافه كنيد تا به  index.htmlيل ادر ف <head>درون تگ  - 6

 .كند

<link rel="stylesheet" type="text/css" href="style.css" media="screen"  /> 

  .اصلي شما را پيدا كند stylesheetمي گويد كه كجا  index.htmlاين به 

 . نيز اشاره كند reset.cssا به بالاي آن اضافه كنيد تا به فايل ررا باز كنيد و خط كد زير  style.cssاكنون فايل  -7

@import "reset.css"; 

 

 CSS stylesheetقبل از هر  ،قرار دارد reset.cssدر فايل كه   reset stylingكه  باعث مي شوداين كار 

  ).مهم مي باشد CSSبري كه به علت مدل ارث( ديگري صدا زده شود

  .را شروع كنيم themeسه فايل اكنون به يكديگر متصل شده اند و ما مي توانيم نوشتن كد  هر! عالي شد
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  ساختار قالب

را ببينيد كمي آن را مطالعه كنيد تا  HTML/CSSدر زير شما مي توانيد ساختار طرح بندي پايه و بخش هاي اصلي قالب 

  .خود را با بخش هاي مختلف طرحبندي صفحه وب آشنا كنيد

 

 كدنويسي بخش اصلي صفحه

بنـدي اضـافه   قطعه كد زير را براي بخـش هـاي طـرح   . كنيمشروع مي index.htmlما با كدنويسي ساختار پايه در  -8

  .كنيد

 <div id="wrap"> 
 <div id="header"> 

 </div><!--end header--> 
 <div  id="featured-content"> 

 </div><!--end  featured-content--> 
 <div id="services"> 

 </div><!--end services--> 
 <div  id="additional-info"> 

 <div  id="client-testimonials"> 
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 </div><!--end client-testimonials--> 
 <div  id="featured-project"> 

 </div><!--end  featured-project--> 
 </div><!--end additional-info--> 

 <div id="footer"> 
 </div><!--end footer--> 

 </div><!--end wrap--> 

  

در بتوانيم به راحتي صفحه وب را قرار داديم تا  wrap#همانطور كه مي بينيد ما تمام بخش هاي اصلي قالب را درون محفظه 

  .دهيممركز قرار 

 ,header, #featured-content, #services ،#services#بخش هاي اصلي طرح بندي وب ما شامل 

#additional-  information ) كه شامل#client-testimonials   و#featured-project و) مي باشد#footer 

 .است

  ايجاد پس زمينه

مـا از روش  . بـرش دهـيم   PSDزمينه را در فايل  سبتدا بايد عكس پا ما، HTML/CSSزمينه قالب  سبراي ايجاد پ -9

اسـتفاده خـواهيم كـرد و تنهـا خلاصـه       در طـول ايـن آمـوزش    CSSزمينه  سبرش عناصر مختلف پاي براي مشابه

 مسـتطيلي  انتخـاب ابزار  ،Photoshopدر : گاماولين . خواهم دادآموزش مختصري از اين روند را در اينجا به شما 

(M)   ايجاد كنيد زمينه سفيد مي باشد،سربرگ و پس را انتخاب كنيد و يك انتخاب باريك كه شامل. 

  

جديـد ايجـاد كنيـد     photoshopرفتـه، يـك سـند     Edit > Copy Mergedوقتي انتخاب را انجام داديـد بـه     -10

)Ctrl/Cmd + N ( و سپس انتخاب را در سند جديد بچسبانيد)photoshop    بايد به صورت خودكار انـدازه ابعـاد

  )داريد، تعيين كند clipboardسند جديد را بر اساس عكسي كه شما در 
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 و كـرده را انتخـاب   GIFفرمـت  . كنيـد ذخيره را فايل  File > Save for Web & Devicesبه  با رفتنبعد از آن  -11

  .ذخيره كنيد imagesدر پوشه  main-bg.jpgسپس آن را با نام 

  .اضافه كنيد تا پس زمينه تنظيم شود stlyle.cssكد زير را به فايل اكنون  -١٢

/*-----------------GENERAL STYLES-----------------*/ 
 body { background: url(images/main-bg.jpg)repeat-x;  font-family: arial; } 

 #wrap { width: 960px; margin: 0 auto; } 

 

صفحه تكرار مي  Xمحور ضميمه مي كنيم و سپس آن را در طول  HTMLدر سند  <body>در اينجا تصوير پس زمينه را به 

  .كنيم

  .بندي صفحه را تنظيم مي كنيم تا مطمئن شويم كه در مركز صفحه قرار مي گيردهمچنين پهناي طرح

.(margin: 0 auto;   ) Bده EF ارIJ KLIF را در MBNOPIQ   

 

  logoكردن  اضافه

لايه اي را . استخراج كنيم PSDبايد ابتدا آن را از  بدين منظور،. اضافه كنيم سربرگرا به  logoاكنون مي خواهيم   -13

 راسـت كليـك كنيـد    ،كنار نام لايـه   thumbnailدر آن ذخيره شده است انتخاب كنيد و سپس بر روي  logoكه 

 .) در زير دور آن دايره كشيده شده است(

 

  .شدبراي شما انتخاب خواهد  logoمتن  اين صورت،به 
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 .رونوشتي از متن ايجاد كنيد، سند جديدي بسازيد و آن را در سند جديد بچسبانيد  -14

را به عنوان فرمت فايـل انتخـاب كـرده و     PNG-24را دوباره انتخاب كنيد،   Save for Web & Devicesگزينه  -15

  .ذخيره كنيد images در پوشه  logo.pngفايل را به نام 

- زمينه شفافي داشته باشد تا بتواند به آساني در هر رنگ پسعكس، پس استفاده مي كنيم زيرا مي خواهيم PNGاز فرمت 

  .زمينه اي نشان داده شود

  .كند تنظيمسايت  logoنام يا را براي  گذارينشانهاضافه كنيد تا  index.htmlزير را به فايل  HTMLاكنون كد  - 16

 <div id="header"> 
 <h1>Design Studio</h1> 

 </div> 

 

تنظـيم   header h1#زمينـه در  را به عنـوان عكـس پـس    logo.pngكنيم تا به گونه اي عمل بايد در اين مرحله  -17

 .اضافه كنيد style.cssقطعه كد زير را به فايل . شود

 /*---------------------HEADER---------------------*/  
 #header { height: 130px; } 

 #header h1 { float: left; background: url(images/logo.png)  no-repeat; 
width: 347px; height: 66px; text-indent: -9999px; margin: 38px 0 0  0; } 

  

  .كنيم اضافه مي h1را به به عنصر  logoدر ابتدا ارتفاع محدوده سربرگ را تنظيم كرده و سپس عكس 

زمينه را به يك عنصر ضميمه كنيم كه تصوير پساستفاده مي CSSزمينه در اينجا ما از تكنيكي به نام جايگزيني تصوير پس

به خارج از صفحه  text-indent: -9999pxمقدار /كند و سپس محتواي مربوط به عنصر را با استفاده از جفت صفتمي

  .كندجابجا مي

را فراهم مي كند و همچنين فهم محتواي صفحات را براي كاربراني كه از  SEO مزاياي CSSزمينه روش جايگزيني تصوير پس

screen readerها استفاده مي كنند آسان تر مي كند.  

 navigationايجاد 

  اضافه كنيد index.htmlزير را به فايل  HTMLكد  navigationبراي ايجاد ناحيه  -18

 
 <div id="header"> 

 <h1>Design Studio</h1> 
 <ul id="nav"> 

 <li><a  href="#">Home</a><span  class="nav-divider">--</span></li> 
 <li><a  href="#">About Us</a><span  class="nav-divider">--</span></li> 
 <li><a  href="#">Services</a><span  class="nav-divider">--</span></li> 
 <li><a  href="#">Portfolio</a><span  class="nav-divider">--</span></li> 

 <li><a  href="#">Contact Us</a></li> 
 </ul> 

 </div><!--end header--> 
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 .اضافه كنيد Style.cssزير را به فايل  CSSاكنون  -19

 #header #nav{ float: right; margin: 72px 0 0 0; } 
 #header #nav li{ float: left; font-size: 16px; } 

 #header #nav a { color: #eee; text-decoration: none; } 
 #header #nav a:hover { color: #00aeef; } 

 #header #nav .nav-divider { color: #eee; padding: 0 10px; } 

 

و همچنين با استفاده از صفت  را به سمت راست صفحه شناور مي كنيم nav#در ابتدا محدوده : بسيار ساده استكد اين 

margin  72آن راpx عناصر  .نسبت به بالاي صفحه جابه جا مي كنيم<li>  سپس به سمت چپ شناور مي شوند تا اطمينان

  .حاصل شود كه تمامي اسامي صفحه در كنار يكديگر نشان داده مي شوند نه در رديف هاي جداگانه

به عنوان جداكننده بين اسامي مختلف صفحه استفاده  "-"مي كند و كاراكتر هاي  آراستهبقي كد به سادگي لينك ها را ما

  .شودمي

 ويژهكد كردن بخش محتواي 

در اينجـا نيـز   . باشـد اولين تصوير، عنوان مي. خود برش دهيم PSDبراي ايجاد اين بخش، ما بايد چندين عكس را از  -20

بنابراين، لايه اي را كـه عنـوان در آن ذخيـره    . استفاده كرديم، دنبال كنيم  logoفرايند يكساني را كه قبلاً در برش 

در آن لايه راست كليك كنيد تا متن انتخاب شود،  thumbnailبر روي  ها انتخاب كردهلايه panelشده است در 

  .جديد ايجاد كنيد Photoshopو سپس يك سند  ردهك copyمتن را 

 & Save for Webبا استفاده از دستور  imagesرا درون پوشه  عنوانوسپس  بچسبانيدمتن را درون سند جديد  -21

Devices آن را ( .ذخيره كنيدfeatured-content-title.png بناميد( 

 
 

چين ، خط نقطه)بناميد featured-content-subtitle.pngاين فايل را ( سپس همين كار را براي عنوان فرعي -22

  .انجام دهيد) featured-content-text.png(و متن ) بناميد horizontal-line.pngآن را ( 

قطعـه كـد زيـر را درون    . مربوطه را بنويسيم HTMLاكنون كه تمام عكس هاي مورد نياز را استخراج كرده ايم بايد  -23

  .اضافه كنيد index.htmlدر فايل  #featured-contentمحدوده 

 
<div id="featured-content"> 

 <h2>Clean and Professional Web  Design</h2> 
 <h3>Providing High Quality Web  Solutions</h3> 

 <div  class="horizontal-line"></div> 
 <p>We provide first class web  solutions for organizations and small 

businesses looking to make a big impact  online. Our services include web design, 
online marketing campaigns, and search  engine optimization.</p> 
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 <div  class="horizontal-line"></div> 
 </div><!--end featured-content--> 

 

  .شوند آراستهاضافه كنيد تا عناصر  style.cssسپس كد زير به فايل  -24

 /*-----------------Tools-----------------*/  
 .horizontal-line{ background:  url(images/horizontal-line.png) no-repeat; 

width: 950px; height: 10px; } 
 /*------------FEATURED CONTENT SECTION------------*/  

 #featured-content { margin: 65px 0 0 0; } 
 #featured-content h2{ background:  url(images/featured-section-title.png) 

no-repeat; width: 811px; height: 66px;  text-indent: -9999px; } 
 #featured-content h3{ background: url(images/featured-section-subtitle.png) 

 no-repeat; width: 720px; height: 57px; margin: -8px 0 30px 1px; text-indent:  -
9999px; } 

 #featured-content p{ background:  url(images/featured-section-text.png) no-
repeat; width: 957px; height: 126px;  margin: 30px 0 25px 0; text-indent: -9999px; 
} 

  

 marginاستفاده از صفت با  65pxبه سمت پايين تا  featured-content#در اين قطعه كدها، با جابه جا كردن بخش 

استفاده مي كنيم تا عكسهايي را كه  pو  h2 ،h3براي عناصر  CSSسپس دوباره از تكنيك جايگزيني تصوير . شروع مي كنيم

  .استخراج كرده ايم نمايش دهد

براي  CSSبا استفاده از توضيحات ( اي نوشته شده استدر بخش جداگانه horzontal-line)(براي خط افقي  استايل دهي

اين كمك مي كند كه كد خود را تميز . چون ما از آن در محدوده هاي ديگر نيز استفاده خواهيم كرد) برچسب زدن بخش ها

 .و سازمان يافته نگه داريم

  ايجاد بخش سرويس ها

آن را بـه اسـم   (زمينـه جعبـه خـدمات آبـي     ما به پس .استخراج كنيم PSDعكس هايي را كه نياز داريم از بايد ابتدا  -25

services-box-bg.png را به اسم  هاآن( هاي بزرگ در هر يك از جعبه ها، سربرگ)ذخيره كنيدweb-design-

title.png ،marketing-title.png  وoptimization-title.png ــد ــره كني ــي  چــينخــط نقطــه ، )ذخي افق

)service-dotted-line.png (زير هر يك از جهبه هـا   و دكمه هايي در)get-more-details-button.jpg ،

view-case-studies-button.jpg و ،learn-more-button.jpg (در انجـام شـده   همان فرايند .  نياز داريم

 .استخراج و ذخيره عكس ها دنبال كنيدپيشين را براي مراحل 
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  .اضافه كنيد index.htmlدر فايل  services#اكنون كد زير را درون محدوده  - 26

 <div id="services"> 
 <div class="service-boxfirst"> 

 <h2  class="web-design-title"></h2> 
 <div  class="service-dotted-line"></div> 

 <p>We provide web design solutions of the very highest order. We’ll  work 
with you from the start to understand your exact requirements and will continuously 
 work with you to ensure that you’re happy with the final site that you  
purchase.</p> 

 <a href="#"  class="more-details"></a> 
 </div><!--end service-box--> 

 <div class="service-box"> 
 <h2  class="marketing-title"></h2> 

 <div  class="service-dotted-line"></div> 
 <p>We can help  you promote your business in both the online and offline 

worlds. We specialize  in a range of fields from viral marketing campaigns to 
managing paid  advertising accounts for you. Your brand will be in safe hands with  
us.</p> 

 <a  href="#" class="view-case-studies-button"></a></div> 
 <!--end service-box--> 

 <div class="service-box"> 
 <h2  class="optimization-title"></h2> 

 <div  class="service-dotted-line"></div> 
 <p>Want to drive more traffic to your site? You’ve come the right  place! 

We can increase traffic to your site in an organic and effective manner  that will 
ensure more people are aware of your business and the  products/services you offer. 
</p> 

 <a href="#"  class="learn-more-button"></a></div><!--end  service-box--> 
 </div><!--end services--> 

 <div class="horizontal-line"></div> 

در  .نسبت داده شده است service-box.در اين قطعه كد، ما سه محدوده جديد اضافه مي كنيم كه به هر سه يك كلاس 

  .چين، متن محتواي آن جعبه و يك دكمه قرار دارد، يك خط نقطههاي خدمات يك عنوان هريك از اين جعبه

 تغييرات ناچيزينيز نسبت داده شده زيرا ما بايد   first (class="service-box first").به اولين جعبه خدمت يك كلاس 

  .ايجاد كنيم اين محدوده نسبت به بقيه  در استايل

  .ها اضافه كنيدراي بخش سرويساصلي خود ب stylecsheetزير را به  CSSاكنون  -27

 /*--------------------SERVICES--------------------*/  
 #services { padding: 40px 0; height: 355px;  } 
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 #services .service-box { float: left; background:  url(images/service-box-
bg.png) no-repeat; width: 233px; height: 301px; margin: 0 0 0 46px; padding: 22px 
28px 30px 26px; } 

 #services .first { margin-left: 0; } 
 #services .service-box h2 { margin: 0 auto; } 

 .web-design-title { background:  url(images/web-design-title.png) no-
repeat; width: 186px; height: 48px; } 

 .marketing-title { background:  url(images/marketing-title.png) no-repeat; 
width: 186px; height: 48px;  } 

 .optimization-title {  background: url(images/optimization-title.png)  no-
repeat; width: 200px; height: 48px;} 

 .service-dotted-line { background:  url(images/service-dotted-line.png) no-
repeat; width: 237px; height: 3px;  margin: 10px 0 24px 0;  } 

 #services p { font-size: 14px; color: #fff; line-height:  21px; text-align: 
center; margin: 0 0 24px 0; } 

 #services .more-details { display: block; background:  url(images/get-more-
details-button.jpg) no-repeat; width: 232px; height: 41px;  } 

 #services .view-case-studies-button { display: block;  background: 
url(images/view-case-studies-button.jpg) no-repeat; width: 232px;  height: 41px; } 

 #services .learn-more-button { display: block; background:  
url(images/learn-more-button.jpg) no-repeat; width: 232px; height: 41px; } 

  

در هرجا كه لازم باشد عكس هاي به طور مناسب نمايش داده شود  CSSزمينه جايگزيني عكس پس كد بالا دوباره از تكنيك

  .استفاده مي كند

 مختلف عناصر بين فاصله و يابي موقعيت براي مختلف عناصر در هاحاشيه و padding تنظيم فقط كلي طور بهموارد  بقيه

  .است

كه باعث ايجاد فاصله  ده استتنظيم ش 46pxبه  service-box.نكته قابل توجه اين است كه حاشيه سمت چپ در كلاس 

داشته باشد در  46pxبا اين حال اگر جعبه اول حاشيه چپي با مقدار . هاي مختلف مي شود service boxمناسب بين 

براي حل اين مشكل ما حاشيه سمت چپ براي كلاس . رسيد گوشه سمت چپ قالب نخواهد بود و ناخوشايند به نظر خواهد

.first  را صفر قرار مي دهيم تا مقدار اصلي صفتmargin  از.service-box styling  را بپوشاند تا اطمينان حاصل شود

  .اول به درستي در سمت چپ قالب قرار مي گيرد service boxكه 

 يانايجاد بخش رضايت نامه مشتر

-clientبــه اســم را فايــل  اســتفاده كــرده واز همــان فراينــد قبلــي . در ايــن بخــش را بــرش دهــيمعنــوان بايــد  -28

testimonials-title.png ذخيره مي كنيم.  
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  .ذخيره كنيد index.htmlدر فايل  client-testimonials#كد زير را درون محدوده  -29

 <div id="client-testimonials"> 
 <h3>Client Testimonials</h3> 

 
 <div class="testimonial"> 
 <div  class="author-img"> 

 <imgsrc="images/author-img-1.jpg" alt="Sarah  Johnson" /> 
 </div><!--end  author-img--> 

 <p>"Design  studios created a beautiful website and were an absolute 
pleasure to work  with..."</p> 

 <p  class="author-name">Sarah Johnson</p> 
 <a  href="#">Web Design Media</a> 

 </div><!--end testimonial--> 
 <div class="testimonial"> 
 <div  class="author-img"> 

 <imgsrc="images/author-img-2.jpg" alt="Kate  Saunders" /> 
 </div><!--end  author-img--> 

 <p>"I only  have great things to say - I would highly recommend DS for 
online promotional  work..."</p> 

 <p  class="author-name">Kate Saunders</p> 
 <a  href="#">Software Solutions</a> 

 </div><!--end testimonial--> 
 

 <div class="testimonial"> 
 <div  class="author-img"> 

 <imgsrc="images/author-img-3.jpg" alt="Dave Cole"  /> 
 </div><!--end  author-img--> 

 <p>"Design  Studios have increased traffic to my site by over 200% in three 
months - great  work guys!"</p> 

 <p  class="author-name">Dave Cole</p> 
 <a  href="#">Global Web Services</a> 

 </div><!--end testimonial--> 
 </div><!--end client-testimonials--> 

  

نامه، رضايتاز نويسنده  يداريم كه هر يك شامل عكس testimonial.ما سه محدوده جديد : شوداين كار به راحتي انجام مي

  .باشدمي شان سازمان/متن آن و اسم نويسنده همراه با نام شركت
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  .اضافه كنيد style.cssزير را به فايل  CSSاكنون  -30

 /*----------------ADDITIONAL INFO-----------------*/  
 #additional-info{ margin: 38px 0 0 0; height: 420px;   } 

 #additional-info #client-testimonials { float: left; width:  425px; 
padding: 0 45px 0 0; } 

 #additional-info #client-testimonials h3 { background: url(images/client-
testimonials-title.png)  no-repeat; width: 180px; height: 28px; margin: 0 0 24px -
5px; text-indent:  -9999px; } 

 .testimonial {  margin: 0 0 32px -5px;  } 
 .testimonial .author-img{ float: left; background-color:  #ccc; width: 

84px; height: 84px; margin: 4px 28px 0 5px; } 
 .testimonial img{ margin: 3px 0 0 3px;  } 

 .testimonial p { color: #555; font-size: 14px; line-height:  21px; margin: 
0 0 12px 0; } 

 .testimonial p.author-name { font-weight: bold; margin: 0;   } 
 .testimonial a { color: #00aeef; font-size: 14px;  text-decoration: none; } 

 .testimonial a:hover { color: #555; } 

  

حاشيه ها محدوده با ارتفاع  -  دنمي باش additional-info#سه خط اول در قطعه كد بالا، همگي در ارتباط با محدوده 

  . مي شودظيم تن

در  45px paddingبا  425pxبه  client-testimonials#يكي از نكات كليدي در اينجا اين است كه پهناي محدوده 

در مورد اين بخش (يكسان باشد  "Featured Project"اين بايد براي اين بخش و بخش . تنظيم شده استسمت راست 

  .چون هر دو از نصفي از صفحه استفاده مي كنند) آموزش صحبت خواهيم كرد انتهايدر  بعداً

بـرش دهيـد و آن    PSDاين عكس را از فايل . اضافه كنيمبه عنوان جداكننده بايد خط عمودي محدوده، بين اين دو  -31

 .ذخيره كنيد vertical-line.pngرا به اسم 

 
 index.htmlدر فايـــل  featured-project#و  client-testimonials#اكنـــون خـــط كـــد زيـــر را بـــين  -32

 .اضافه كنيد

<div class="vertical-line"></div> 

 

 .تعريف كرده ايم قرار دهيد كه قبلاً horizontal-line.كلاس  پايينرا زير  CSSسپس قطعه كد  -33



  خودآموز طراحي وب به صورت عملي

 

 

.vertical-line { float: left; background:  url(images/vertical-line.png) no-repeat; 

width: 4px; height: 385px; } 

  .بالا خط عمودي بين دو بخش مختلف نشان داده خواهد شد CSSبا استفاده از  

  ويژهايجاد بخش پروژه 

 Featured"دارشده سربرگ بخش پروژه خصيصه بايد )client testimonials(نامه مشتري همانند بخش رضايت -34

Project"  را از قالبPSD فايل را به اسم . برش دهيمfeatured-project-title.png ذخيره كنيد.  

  

  .بيافزاييد index.htmlزير را به فايل  HTMLگذاري اكنون قطعه كد نشانه -35

 <div id="featured-project"> 
 <h3>Featured Project</h3> 

 <h4>Yoshi Online Marketing  Campaign</h4> 
 <imgsrc="images/featured-project-image.png"  alt="Yoshi Screenshot" /> 

 <p>This project involved organizing  an online marketing campaign to help 
promote the Yoshi brand. This resulted in  a 200% increase in Yoshi’s sales over a 
six month period of time. </p> 

 <a href="#">Click Here  For More Details >></a> 
 </div><!--end featured-project--> 

 

  .كند styleرا  "Featured Project"اضافه كنيد تا بخش  style.cssزير را به فايل  CSSسپس قطعه كد  - 36

 /*----------------FEATURED PROJECT----------------*/  
 #featured-project { float: left; margin: 0 0 0 45px; width: 425px; } 

 #featured-project h3 { background:  url(images/featured-project-title.png) 
no-repeat; width: 160px; height: 32px;  margin: 0 0 16px -5px; text-indent: -
9999px; } 

 #featured-project h4 { font-size: 20px; color: #888;  font-weight: normal; 
margin: 0 0 8px 0; } 

 #featured-project img{ margin: 0 0 7px 0; } 
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 #featured-project p { font-size: 14px; color: #555;  line-height: 21px; 
margin-bottom: 7px; } 

 #featured-project a { color: #00aeef; font-size: 14px;  text-decoration: 
none; } 

 

استفاده مـي   CSSتكنيك جايگزيني عكس . در سمت چپ مي باشد 45px paddingبا  425pxدوباره پهناي اين محدوده 

را با مابقي كه به سادگي با حاشيه ها، رنگها و اندازه قلم عنصرهاي مختلـف تنظـيم    دارشدهخصيصه شود تا عنوان بخش پروژه

  .وند نشان داده شودمي ش

  پاورقي: كدنويسي بخش آخر 

  .اضافه كنيد index.htmlزير را به فايل  HTML. بسيار ساده است كدنويسي پاورقي -37

 <div id="footer"> 
 <div class="horizontal-line"  style="clear: both"></div> 

 <p>Copyright &copy; 2010 ~  Design Studios ~ All Rights Reserved</p> 
 </div><!--end footer--> 

. باشـد  footer#و  additional-info#در پاورقي ما فقط خط افقي ديگري را نشان مي دهيم تا به عنـوان جداكننـده بـين     

  .در زير آن نشان داده مي شودحق رونوشت متن  سپس

  .اضافه كنيد footerش كردن بخ styleبراي  style.cssزير را به فايل  CSSاكنون قطعه كد   -38

 /*--------------------FOOTER----------------------*/ 
 #footer { height: 70px; padding: 0 0 30px 0; } 

 #footer p { font-size: 16px; color: #888; padding: 14px 0 0  0; } 

 30pxپـايين را بـه    paddingرا تعريف مي كنيم و سپس  footer#ارتفاع محدوده : در اينجا خيلي راحت است استايل دهي

  .دشوبندي وب ايجاد قالب طرح پاييندر  فضاي خاليمي كنيم تا  تنظيم

در بالا مي دهيم تا متن را از خـط   paddingما همچنين رنگ و اندازه قلم متن حق رونوشت را تنظيم كرده و به آن مقداري 

  .افقي دور كنيم

  !پايان

  .، شما چيزي شبيه تصوير زير خواهيد داشتاگر همه چيز بر طبق برنامه پيش رفته باشد. كار تمام شد
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  بخش شماره چهار

قصد دارم نحوه ساخت قالب يك وب سايت توسط فتوشاپ را به صورت مرحله به مرحله براي شما آموزش  آموزشدر اين 

در پايان سورس را براي شما قرار خواهم داد تا . ستاد براي خودتان استفاده كنيد و رايگان يناتو اين قالب را شما مي. مهبد

 .اميدوارم برايتان مفيد واقع شود. آنرا دانلود كنيد

تصوير . ابزارها و افكتهاي مختلف داشته باشيد ن باقبل از شروع ، بهتر است شما آشنايي متوسطي با فتوشاپ و نحوه كار كرد

 : توانيد مشاهده نماييد نهايي كار را مي

 

  

  

  آموزش منبع

hLp://p5x.co/12273 
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 : پيكسل ايجاد كنيد 1000در  950ابتدا يك فايل جديد به اندازه 

 

يا از (را فشار دهيد تا خط كش در فتوشاپ روشن شود  ctrl+r سپس. را به مشكي تغيير دهيد background سپس رنگ

 .پيكسل از سمت چپ و راست تصوير بكشيد 25به اندازه  guide حال دو عدد .(rulers و انتخاب view طريق منوي

لدرها براي هميشه بهتر است كه هنگام كار با فتوشاپ از فو. (درست كنيد header در پنل لايه ها يك فولدر جديد به نام

 5شعاع آنرا . را انتخاب كنيد Rounded Rectangle Tool حال از منوي ابزار ، ابزار .(سازماندهي كار خود استفاده كنيد

 .پيكسل بكشيد 300ديگر به اندازه  guide از بالاي صفحه يك. پيكسل قرار دهيد

و يك مستطيل درون اين فضاي تشكيل شده  323232: انتخاب كنيد  foreground حال اين كد رنگ را به عنوان رنگ

 فعال snap همينطور گزينه. را انتخاب كنيد smart guides و Showگزينه  view هميشه بهتر است از منوي. (بكشيد

  )دباشد تا موقع كار به شما كمك كن

 

را طبق شكل  stroke هرا انتخاب كنيد، سپس گزين blending options كنيد و right click حال روي لايه ايجاد شده

 : زير اعمال كنيد
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 رنگ. پيكسل بكشيد 250به اندازه  guide پيكسل ، و از سمت بالا يك 40به اندازه  guide دوباره از سمت چپ و راست دو

foreground  را به اين كد رنگbe0000  تغيير دهيد و دوباره يك مستطيل در اين محوطه بكشيد : 
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 : هاي زير را به آن اعمال كنيد effect حال

 

 

 .مي باشد fdc171 كد outer glow كد رنگ براي افكت

را گرفته و  alt حال يك عكس دلخواه از كره زمين انتخاب مي كنيم و آنرا در بالاي لايه قرمز رنگ قرار ميدهيم سپس دكمه

 : ميكند و سپس كليك مي كنيمموس را در پنل لايه بين اين دو لايه ميبريم كه بدين شكل تغيير 
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 : كنيم تغيير ميدهيم و افكت زير را به آن اضافه مي soft light لايه كره زمين را به blending از پنل لايه حالت

 

 .مي باشد f02e2e كد outer glow كد رنگ براي افكت
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 : تا به حال بايد تصوير شما شبيه شكل زير باشد

 

را به رنگ  foreground را انتخاب كنيد، رنگ brush ايجاد كنيد، از پلت ابزار new layer زمين يكحال روي لايه كره 

متمايل به نارنجي تغيير دهيد، من از اين براش استفاده كردم، شما مي توانيد از براشهاي مختلف و متنوعي براي اين كار 

توجه داشته باشيد كه اين لايه ها بايد با لايه (تكرار ميكنيم  استفاده كنيد ، اين كار را توسط ايجاد چند لايه جديد ديگر

  ) altشوند با نگه داشتن دكمه mask زيرين خود

 

  

  

  

  

  

  

  

  

  

  



  خودآموز طراحي وب به صورت عملي

 

 

 : هست linear dodge آنها blending دو لايه بالايي حالت

 

براش به اندازه زير انتخاب كنيد يك . مي كنيم maskحال دوباره يك لايه جديد ديگر بالاي اين لايه ها ايجاد ميكنيم، آنرا 

  )براش دايره اي شكل(

 



  خودآموز طراحي وب به صورت عملي

 

 

 : رنگ نارنجي انتخاب كنيد و در گوشه مستطيل يك بار كليك كنيد

 

درصد تغيير داده و در گوشه ديگر مستطيل يكبار كليك  50آنرا به  opacity حال رنگ براش را به مشكي تغيير دهيد ، مقدار

 : كنيد

 

 : قرار مي دهيم header برايحال يك تصوير دلخواه 

 

 : (من از نرم افزار فارسي ساز مريم براي اين كار استفاده كرده ام(براي هدر متن مورد نظر را قرار ميدهيم 

 



  خودآموز طراحي وب به صورت عملي

 

 

متن لينكهاي مورد نظر را دورن آن قرار مي . ايجاد ميكنيم navigation يك فولدر جديد به نام header حال درون فولدر

 : دهيم

 

را انتخاب كنيد و يك خط  line tool ت بين لينكهاي منو يك مرزي ايجاد كنيم تا بهتر نمايان شوند، براي اين كاربهتر اس

تغيير دهيد و آنها را به شكل زير  666666كوچك با رنگ مشكي ايجاد كنيد و سپس از آن يك كپي بگيريد و رنگ آنرا به كد 

 : در كنار هم قرار دهيد

 

 guide براي شروع از سمت بالا دو. در سايت تكميل شد، حال سراغ قسمت آيكانهاي سرويس ها ميرويمخب تا الان قسمت ه

پيكسل به ابعاد  5يك مستطيل با شعاع  rounded rectangle tool حال توسط .پيكسل بكشيد 505و  315به فاصله 

 .قرار دهيد 323232رنگ آنرا . پيكسل بكشيد 190در  140

pen tool ب كنيد، يك منحني به رنگ سفيد و به شكل زير ايجاد كنيدرا انتخا : 



  خودآموز طراحي وب به صورت عملي

 

 

 

ايجاد شده است  pen tool كنيد، روي لايه اي كه توسط mask حال آنرا با لايه زيرش كه همان مستطيل اوليه هست

 reveal و سپس layer mask و انتخاب layer يا از منوي. (را انتخاب كنيد add mask كليك كنيد، از پايين پنل لايه

all) ابزار gradient را انتخاب كنيد و روي mask به صورت مورب gradient  رنگ پيش فرض)بكشيد gradient سفيد -

 : (مشكي باشد

 

آن  layer styleرا انتخاب كنيد و يك مستطيل كوچك درون مستطيل بكشيد،  rounded rectangle tool حال دوباره

 : كنيد paste و copy مستطيل قرمز رنگ layer style را از



  خودآموز طراحي وب به صورت عملي

 

 

 

حال يك براش دايره اي شكل و كوچك انتخاب كنيد، بالاي لايه مستطيل يك لايه جديد ايجاد كنيد، رنگ مشكي را انتخاب 

 : بكشيد opacity درصد 50را نگه داريد و درون مستطيل قرمز رنگ يك خط با  shift كنيد براي براش، دكمه

 

 : اثر كوچك توسط براش به رنگ نارنجي در گوشه اين مستطيل كوچك هم قرار مي دهيم مانند مستطيل قرمز رنگ هدر يك

 

تبديل كنيد تا  smart object خب كار اين باكسها تمام شد، بهتر است همه لايه هاي اين باكس را انتخاب كنيد و آنها را به

ظر از اين باكسها درون قالب خود قرار ميدهيم و آيكانها و حالا به تعداد مورد ن. در آينده بتوانيم راحت تر از آن استفاده كنيم

 : اين قسمت هم آماده شد. متن دلخواه خود را نيز روي آنها مي گذاريم



  خودآموز طراحي وب به صورت عملي

 

 

 

 : قالب، يك مستطيل بزرگ با استايل مستطيل طوسي رنگ هدر مي كشيم body براي قسمت

 

ميكشيم و استايل  de0000 مستطيل به كد رنگ بدين روش عمل مي كنيم، يك body براي باكسهاي قسمت تايتلهاي

 : هاي زير را به آن مي دهيم

 



  خودآموز طراحي وب به صورت عملي

 

 

 

 

قسمت ار  3كپي از اين باكس در قالب قرار ميدهيم، متن مورد نظر را مي نويسيم، مانند قسمت منو براي جدا سازي اين  3

 : استفاده ميكنيم line tool ابزار



  خودآموز طراحي وب به صورت عملي

 

 

 

 .هم ميتوانيم يك باكس قرار دهيم footer قسمت خب تقريبا قالب آماده شده است، فقط براي

تبديل كنيد و لينكها و متن مورد نظر  CSS و  HTML اين قالب آماده تبديل شدن به وب سايت است، آنرا مي توانيد به كد

براي آموزش تبديل قالب به كد مي توانيد از . اميدوارم از اين آموزش استفاده كافي را برده باشيد. خود را در آن قرار دهيد

 .داتيس ديزاين بهره ببريد design2code آموزشهاي همين وبلاگ استفاده كنيد، و يا از سرويس 

  

  

  


